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Moodle™ 4.0/4.1 New Features 
New for All Users 

1. Calendar 
a. The Calendar link has been removed from the Site pages sub-menu of the Navigation 

block and now is in the User menu. This new Calendar link is no longer context-
sensitive to being activated while in a course. Rather it always goes to the site-level 
calendar for the user.  

b. The Monthly view block (the 3-month view) has been removed from the Calendar page. 
c. A “current date” indicator has been improved to the Calendar page. 
d. The number of events displayed on a single date on the calendar is limited to 5. If more 

than 5 events exist on a single day, the Calendar will display the first 4 and add text 
below indicating how many more exist. For example, if there are 6 events, it will show 4 
and have a link reading "2 more" that will open the “day view” for the date. 

e. An Import or export calendars link has been added replacing the Export calendar and 
Manage subscriptions button. This opens the “Import or export calendars” page. 

i. This page offers the Import calendar and Export calendar buttons.  
ii. This page also displays the “Imported calendars” area where subscriptions to 

calendars can be managed. 
 

2. Calendar block 
a. Display has been made more responsive to screen sizes.  
b. Event type filters have been removed. 
c. A Full calendar link has been added that takes the user to the site-level calendar.  
d. An Import or export calendars link has been added. This opens the site-level ”Import 

or export calendars” page described above.  
 

3. Courses 
a. A secondary set of Navigation links are available at the top of course pages. Most of 

these are alternatives to the links that are available for the course via Navigation block. 
b. All activity/resource icons have been updated to help differentiate the purpose of the 

different resources/activities.  
c. Courses in Topics or Weekly format have collapsible topic sections. 

 
4. Dashboard  

a. Both the Timeline and Course overview blocks now offer a Search field. 
b. Drop-down menus in the Timeline block now show their current selection when 

collapsed. 
c. Timeline block now won’t display courses that don't have any active events (before it 

said "No activities require attention"). 
d. Improved displaying of overdue items in the Timeline block, including overdue "earlier 

today" items, and indicating each item as overdue rather than collecting them per date. 
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5. Login page 
a. Can now select language for the login page if multiple languages are enabled. 
b. Cookies notice is now a button on the login page. 
c. No longer a checkbox to Remember username although cookies will be used in 

accordance with the Remember username option on the Site security settings page 
and the user’s browser configuration. 
 

6. Navigation 
a. My Courses link in the Navigation block now goes to a dedicated page containing an 

instance of the Course Overview block. 
 

7. Notification System 
a. In the Notification Preferences, removed the distinction between “online” and “offline” 

and simplified the UI labels. 
 

8. TinyMCE Editor 
a. A new, updated version of the TinyMCE editor is available for use. The original version 

has been renamed “TinyMCE HTML editor (legacy)”. 
b. When adding images, the Appearance and Advanced tabs have been removed from 

the Insert image dialog. 
c. The process and configuration options for adding tables have changed in the new 

TinyMCE editor. 
 

9. User menu  
a. Default User menu items now include links to Profile, Grades, Calendar, Private files, 

Reports, Preferences, and Log out. 
i. Profile link has been added to the User menu by default and operates as expected. 
ii. Calendar link has been added to the User menu by default and opens the site-level 

Calendar page. 
iii. Private files has been added to the User menu by default and operates as 

expected.  
iv. Reports User menu item is new and will open the Custom reports page.  

b. Access to Messages is no longer available in the User menu by default. Users must 
use the Toggle messaging drawer message notification icon ( ) to open the 
Messaging drawer unless other links to the Messaging page are provided.  
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New for Course Developers and Instructors 

1. Activity/Resource Management 
a. When course is in editing mode, the text Edit menu has been replaced with an Edit 

menu icon of vertical ellipses ( ). 
b. When a course is in editing mode, Group mode indicators/toggles are no longer 

available next to the activity/resource Edit menu. 
c. Add an activity or resource is now within the last panel of each topic section, providing 

a clear indication of where the new activity/resource will be placed. 
d. A Settings link has replaced the Edit settings link in the activity/resource administration 

menu. 
e. Common module settings now include the ability to Force language at the 

activity/resource level 
f. Common module settings now include the ability to indicate whether to Include in 

course content download the activity/resource content.  
g. Activities and resources now have a Send content change notification option at the 

bottom of the settings page that will notify enrolled users when the content of the 
activity/resource has changed 
 

2. Activity Completion 
a. Most gradable activities now have a “Student must receive a passing grade to complete 

this activity” option available as a criterion for activity completion.  
 

3. Activity Overrides 
a. There is now a single Overrides link for activities Administration block. The distinction 

between user and group overrides is now made on the Overrides page for the activity. 
 

4. Administration block 
a. The ability to “turn editing on” has been removed from the course administration menu. 
b. A Settings link has replaced the “Edit settings” link in the course administration menu. 

 
5. Assignment activity 

a. New Time limit setting is available as a configuration option in the Assignment settings 
if enabled at the site-level. 

b. New Activity instructions field. Content of this field is only shown on the Submissions 
page once the learner has started the assignment. 
 

6. Cohort enrollment 
a. Can no longer assign a custom name to a Cohort sync enrollment method instance. 

Rather the name presented on the Enrollment methods page will be “Cohort sync (‘name 
of cohort’)” 

b. When creating a Cohort sync enrollment method instance, multiple cohorts can be 
selected at once. When saved this will create a separate Cohort sync enrollment method 
instance for each Cohort identified. 
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7. Competencies 
a. New option to Override existing competency grade when completed is available for 

activities/resources that have been linked to competencies. 
 

8. Course Administration Navigation 
a. Courses now have a series of tabs along the top of the page that provide access to 

major course administration pages including Settings, Participants, Grades, Reports, 
and a More section containing a variety of options. Fundamentally, this provides an 
alternative to accessing the Course administration menu which contains the same 
functions. Sub-pages for major sections are available via a drop-down at the top of the 
page. 
 

9. Course Settings 
a. The link in the Course administration block that is used to access the Course settings 

page has changed from Edit settings to now simply Settings. 
b. The choices available in the Hidden sections option of the course settings have been 

updated to provide greater clarity on their function. They now include “Hidden sections 
are shown as not available”, “Hidden sections are completely invisible”, and “Hidden 
sections are shown in collapsed form with available message”. 
 

10. Database activity 
a. New UI guides initial construction of the Database activity. 
b. Three new presets join the existing “Image gallery”: “Journal”, “Proposals”, and 

“Resources”. 
c. Add entry, View list and View single tabs have been removed from the tab navigation 

area. Now, once a Database contains at least one row of data, the Database tab will 
have a drop-down offering the “List view” and “Single view” views and the Add entry 
view is accessed via a button at the bottom of the page. 

d. The Templates tab now offers a drop-down to access the various views for the 
Database, rather than a secondary tab interface.  
 

11. Gradebook 
a. New Grade Summary view of the gradebook displays the average score for every grade 

item. This view is filterable by activity type. 
b. Accessing the Feedback, Override, and Exclude functions of the Single View now 

requires being in edit mode by selecting Turn editing on.  
c. In the Single View, if a grade item offers a summary information page for the learner’s 

attempt, a drop-down menu will be available offering a Grade analysis link directly to 
that page. 

d. New Actions menu in the Single view, available when in editing mode, contains the 
options to Override all/none, Exclude all/none, and Bulk insert grades. 

e. User Report now has collapsible grade categories. 
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f. LTI activities listed in the gradebook will now have a link to directly open the LTI activity. 
 

12. H5P 
a. Content bank allows users to switch context via a drop-down menu. Ability to Add H5P 

to a given context is sensitive to the user’s permissions within the context. 
 

13. Languages 
a. Course language can be overridden at the individual activity/resource level.  

 
14. LTI 1.3 (LTI Advantage) support 

a. Legacy LTI (1.1/2.0) tools are deprecated. While they will still function for the time being, 
it is recommended that content should now be shared using LTI Advantage. 

b. LTI Advantage has some configuration differences that will need to be considered. 
 

15. Page resource 
a. The ability to Display page name has been removed from the Page resource settings. 

 
16. Quiz Activity 

a. Quiz Administration menu option Questions replaces the Edit quiz menu option. 
b. When viewing the Questions of a Quiz activity, can choose which version of each 

question to use (defaults to “Always latest”). 
c. A permission - mod/quiz:emailnotifyattemptgraded - is available that will allow an 

automatic notification to be sent to learners upon the manual grading of a Quiz question. 
 

17. Question Bank 
a. Question bank no longer has a tabbed interface, but now uses drop-down navigation to 

access the Questions, Categories, Import, and Export pages. 
b. The Edit menu for each question now has a History option which will display the version 

history of a single question.  
i. A “Modified by” column is now displayed in the Question bank. 

c. Can directly modify a question’s Status in the Question bank view. 
d. A new Comments function is available for each question allowing anyone with access to 

that Question bank context the ability to add and review comments made on the 
question. 

e. Once a question has been used in a Quiz activity that has been attempted by learners, 
the LMS will evaluate the performance of the question and produce a Facility index and 
Discriminative efficiency value for the question. This will then inform whether the LMS 
indicates if the question may Need checking to consider improvements.  

f. The Question bank now provides a Usage link for each question that indicates the 
number of times that the question has been used in a Quiz. This number is a link to a list 
of all courses/Quiz activities in which the question is referenced.  

g. Question bank now indicates when a question was Last used, indicating the last time it 
was attempted by a learner. 

h. Question names can be edited directly on the Question bank view. 
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i. Questions track their history using a Version number. Each time an update is made to a 
question, its version number is incremented. 

j. Questions have a Question status field where the question can be marked as either 
“Draft” or “Ready”. Draft questions will not appear as available for the addition to Quiz 
activities.  

k. WebCT and Examview question import format has been removed. 
 

18. Questions 
a. Can no longer change the question’s Current category from the editing question view. 
b. New field for Question status 

i. “Draft” questions are not available to be added to Quiz activities. “Active” 
questions are available to be added to Quiz activities. 

c. True/False questions offer the ability to configure whether to Show standard 
instructions or not. 
 

19. Text and Media Area 
a. This is the new name for the Label resource. The Text and Media Area should function 

just as Labels functioned in the past. This is a name change only. 
 

20. Text Block 
a. The HTML Block has been renamed to Text block. No other functionality has changed. 

 
21. Topic Sections 

a. An Add topic link appears between each topic section rather than just below the last 
topic section. 

b. Topic sections in “Topics” or “Weekly” formats are collapsible on the main course page. 
c. Move, Move up, and Move down functions, as appropriate, are available in each Topic 

section’s Edit menu. 
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New for Site Administrators 

1. Advanced features 
a. New options here include Enable competencies, Enable messaging system, Enable 

custom reports, Enable web services for mobile devices and Enable MoodleNet 
integration.  
 

2. Assignment activity 
a. Site-level setting available to Enable timed assignments. 

 
3. Creating Courses 

a. When a new course is saved, the main course page is now loaded. Site administrators 
are no longer immediately redirected to the Enrolled users page. 
 

4. Course default settings 
a. Can now define the Number of participants per page that are displayed on the 

Participants page. 
b. The options for Hidden sections have been updated for clarity and now include “Hidden 

sections are completely invisible” and “Hidden sections are shown as not available”. 
 

5. Dashboard 
a. Can be explicitly disabled for all users by deactivating Enable dashboard at Site 

administration ► Appearance ► Navigation. 
 

6. Gradebook settings 
a. The ability to configure the Navigation method for gradebooks has been removed from 

Site administration ► Grades ► General settings. The only option for navigating 
gradebooks is now the “drop-down menu” approach. 
 

7. H5P 
a. Embedded H5P interactives, whether added via the core H5P activity or via the Atto H5P 

button or other means will offer an Edit H5P content link to those with the appropriate 
permissions which allows for inline editing of the content. 
 

8. Landing/Start Page 
a. Start page for users (formerly Home page for users located at Site administration ► 

Appearance ► Navigation) an explicitly set whether users’ start page will be the 
“Home” (or Front) page, their “Dashboard”, their “My courses” page, or whether users 
should be allowed to select their own “User preference”. The My Courses page contains 
a single Course Overview block. This is the same block that can be found on the 
Dashboard. This is done at Site administration ► Appearance ► Navigation. 
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9. Messaging  
a. The option to enable/disable the Messaging function site-wide has been moved to the 

Advanced features page. 
 

10. Notification system 
a. Jabber has been removed as a notification channel. 
b. The UI of the site Notification preferences page has been improved for usability.  

 
11. OAuth2 Authentication 

a. Clever has been added as an OAuth2 service provider. 
 

12. Question Bank 
a. Can enable/disable most discreet functions in the Question Bank at Site administration 

► Plugins ► Question bank plugins ► Manage question bank plugins.  
b. Can customize the order of the columns in the Question Bank. This is done at Site 

administration ► Plugins ► Question bank plugins ► Column sort order.  
 

13. Questions 
a. The ability to create custom question fields and field categories is available. 

i. Field types include Checkbox, Date and Time, Dropdown menu, Short text, and 
Text area 
 

14. Quiz activity 
a. Site-level setting to configure Attempt graded notification delay. This supports the 

new functionality to notify learners when Essay questions have been manually graded. 
 

15. RecordRTC Text Editor Plugin Settings 
a. The recording time limit setting has been split into separate audio and video time limit 

settings. 
 

16. Report Builder 
a. Offers the ability to build custom reports based on a defined set of “report sources” that 

include Badges, Blogs, Cohorts, Comments, Course Participants, Courses, Files, 
Groups, Notes, Tags, Task Logs, and Users 

b. Reports can be shared to users via their Reports link in the User menu. This is done by 
assigning user Audiences to the report. Audiences can be defined by groups that 
include “All Users”, assigned system roles, specific named users, members of a cohort, 
or site administrators.  

c. Reports can be generated and emailed to users on a scheduled, recurring basis. 
 

17. User Menu 
a. Link to Profile is no longer mandatory and can be removed if desired. 
b. Link to Preferences is now mandatory and cannot be modified or removed. 
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18. Upload Users 
a. Can now assign users category roles via CSV upload by using "categoryx" and 

"categoryrolex" column headers. Category must be identified by Category ID number. 
b. The upload users process now can match users by email via the CSV file.  

 
19. User Tours 

a. User tour settings now include the ability to define the End tour button’s label.  
b. Can confiture the User tour to automatically Display step numbers. 
c. When creating a Tour step, can identify the Content type to be either “Manual” or 

“Language string ID” to reference an existing string in an installed Language pack. 
d. When creating a “Manual” Tour step, the preferred HTML editor can now be used to 

enter the content. This allows video, images, and links to be added to the Tour step 
more efficiently than before. 
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